
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

BY JODY CULKIN  

Arduino 

क्या है? 

यह एक ओपन सोस स इलेक्रॉननक्स 
प्रोटोटाइप प्लेटफार्म है।  
इसका मतलब क्या है? 

“संसाधनों जिनका फ्री में उपयोग या वितरित या पुन: ललखित ककया जा सकता है िैसे सॉफ्टिेयि या हार्सिेयि।” 

“टेक्नोलॉिी जो विलिन्न र्ीडिया के द्वारा इलेक्रॉनों के ननयंत्रित गनत का उपयोग करती है |” 

“एक मूल रूप जो अन्य चीिों के ललए एक आधाि, मानक और र्ॉिल देता है |” 

“सॉफ़्टिेयि फे्रर्वकम  के साथ हार्सिेयि आर्कम टेक्चर जजस पि अन्य सॉफ्टिेयि चल सकते हैं |” 

ओपन सोसस - 

इलेक्ट्रॉननक्ट्स - 

प्रोटोटाइप - 

प्लेटफार्स - 



एक Arduino में र्ाइक्रोनिप होता ह,ै जो एक बहुत छोटा कंप्यूटर होता ह ैजजसे आप प्रोग्राम कर सकते हैं। आप उस पर सेंसर लगा सकते हैं जजससे वातावरण की कंडीशसं को माप 

सकते हैं (जैसे कमरे में जकतना प्रकाश ह)ै। दूसरी चीज़ो को इन कंडीशसं पर क्या करना ह ैको कण्ट्रोल कर सकता ह ै|  (जब कमरे में अंधेरा होता ह,ै अपने आप जल जाती ह|ै ) 
 

माइक्रोचिप (Microchip) 
फोटोशेल (Photocell) 

बै्रडबोडस  (Breadboard) 

LED 

ON OFF 

जब एक जविच दबाया जाता है, तब यह कुछ एक्शन ले सकता है|  

र्ाइक्रोकंट्रोलर, एक कंप्यूटर की तरह इनपुट और आउटपुट का उपयोग करते 
हैं | इनपुट, यूिर या पयामवरण से इनफार्ेशन को कैप्चर करते हैं, िबर्क 
प्राप्त इनफार्ेशन पर प्रोसेस के बाद, आउटपुट उसको स्क्क्रीन पर दशामता है | 

रे्वकटॉप कंप्यूटि के ललए माउस 
एक इनपुट डर्िाइस है, औि 
मॉननटि एक आउटपुट डर्िाइस है 
| 



OFF 

Arduino में इनपुट, एक जविच या सेंसि हो सकता है | 
र्कसी वस्क्तु को एक आउटपुट के द्वारा ऑन, ऑफ औि ननयंत्रित 
र्कया िा सकता है। यह एक र्ोटर या एक कंप्यूटर भी हो सकता 

है | 

जस्क्वच एक डिजिटल इनपुट और सेंसर एक एनालॉग इनपुट है| एनालॉग 
सेंसर की रेंि, इसको डिजिटल िेटा र्ें बदलने से ननर्ामररत होती है | 

 

डिजिटल औि एनालॉग इनपुट 
औि आउटपुट के बीच अंति 

क्या है ? 

इनपुट और आउटपुट, डिजिटल या एनालॉग हो सकते हैं | डिजिटल 
इनफार्ेशन बाइनरी होती है- यह या तो TRUE या FALSE होता है| 
एनालॉग इनफार्ेशन ननरंतर होती है, यह कई वैल्यूि ले सकती है| 

डिजिटल इनफार्मेशन असतत 
औि परिलमत है | सभी 

इनफार्ेशन को दो प्रकार से, 
'1' या '0' , 'ऑन' या 'ऑफ' 
से पे्रिेंट र्कया िाता है। 

एनालॉग इनफार्मेशन इसकी 
ननिंति प्रकृनत द्िािा िाना 
िाता है | इसमें संिावित 
वैल्यूि की संख्या अनंत हो 

सकती है | 



िोल्टेज?  
करंट?  

प्रनतिोध?  
ओम का ननयम? 

Arduino को प्लग करने से पहले, हर्ें कुछ 
शब्दों और ससद्ांतों की सर्ीक्षा करनी चाहहए 
र्क इलेजक्ट्रससटी (और इससलए इलेक्ट्रॉननक्स) 

कैसे कार् करती है ? 
विद्युत एक सुचालक रै्टेररयल र्ें विद्युत ऊजास का प्रिाह है। 

 

  िोल्टेज (V) 
एक सककस ट में विद्युत 
क्षमता को र्ापता है । 
यह िोल्ट (volts) में 

मापा जाता है | 
 

करंट (I)  
एक सुचालक रै्टेररयल 
र्ें विद्युत प्रिाह की 
मािा है यह एम्पीयि 
(amperes) या 

एम्पप्स (amps) में 
मापा जाता है| 

प्रनतिोध (R)  
विद्युत धािा के प्रिाह 
का अवरोर्क है। यह 
ओम (ohms) में मापा 

जाता है | 

सामान्यतः इन शब्दों को समझाने के ललए पानी के समानता का उपयोग ककया जाता है| यहााँ एक मॉर्ल है | 

विद्युत प्रिाह की गनत िोल्टेज से ननधासरित 
होती है | 

प्रनतिोध के कारण, विद्युत प्रिाह बढ़ता 
या घटता है | 

पाइपों में चलने िाले प्रिाह की मािा करंट होती है| 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

- 
 
 
 

 

+ 

Lamp 

Ohm’s law ओम का ननयम 
Current = Voltage/Resistance      

(I= V/R)               करंट = िोल्टेज / प्रनतिोध 

OR 
Resistance = Voltage/Current            

(R = V/I)               प्रनतिोध = िोल्टेज / करंट 

OR 
Voltage = Resistance * Current      

   (V = R*I)            िोल्टेज =  प्रनतिोध * करंट 

 

एक जमसन िौनतक विज्ञानी जॉजस ओम द्िािा की गई िोल्टेज, 
ित समान औि प्रनतिोध के बीच संबंध है | 

 

उदाहिण के ललए:  

प्रनतिोध में िृवि => कम प्रिाह  िोल्टेज में िृवि => अधधक प्रिाह 

अब हम एक साधािण सककस ट लेते हैं| हर सर्कम ट, एक बंद लूप होता 
है, जिसर्ें एक ऊिाम स्रोत (बैटरी) और load (लैंप) होता है। Load, 
बैटरी की ववद्युत ऊिाम को पररवनत मत करके इसका उपयोग करती है। 

इस सर्कम ट र्ें एक जस्क्वच भी है | 
 

यह एक ही सर्कम ट का एक स्क्कीरै्हटक (schematic) है (यह इलेक्ट्रॉननक 
कंपोनेंट्स के सलए ससम्बल्स का उपयोग कर सर्कम ट को दशामता है)। िब 
जस्क्वच ऑन होता है, तो त्रबिली के स्रोत स ेकरंट प्रवाह होता है और लैंप 

ऑन हो िाता है | 

Current Flow 

Switch 
DC Power 

Source 
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OFF 

सककस ट के दो सामान्य प्रकाि हैं, direct current और alternating 
current । र्ी.सी. सककस ट में, करंट हमेशा एक ददशा में बहती है। 

ए.सी. सककस ट में, ननयलमत cycles में विपिीत ददशाओ ं में करंट प्रिाह 
होता है। हम यहााँ केिल र्ीसी सककस ट्स के बािे में ही बात किेंगे | 

|” 

अब जब हमने कुछ मूल बातें की समीक्षा की है 
कक त्रबजली कैसे काम किती है, तो हम िापस 

Arduino पि आ जाते हैं | 
 

Arduino को चलाने के सलए पावर की िरूरत होती है, प्रोग्राम किने 
के ललए इसे कंप्यूटि से अटैच किना होगा। 

 

एक USB केबल के साथ कंप्यूटि से Arduino को अटैच करने पि, 
Arduino ऑन हो िाता है औि अब हम प्रोग्रालमंग शुरू कर सकते हैं| 

आपको Arduino को प्रोग्राम करने के सलए सॉफ़्टिेयि िाउनलोि औि 
इवंटॉल किना होगा। यह ऊपर हदए URL पर फ्री र्ें उपलब्ध है | 

Arduino सॉफ्टिेयि Mac OS X, विरं्ोज (Windows) औि ललनक्स 
(Linux) प्लेटफामों पि चलता है। 

DOWNLOAD HERE: 

 

HTTP://ARDUINO.CC/EN/MAIN/SOFTWARE 



Mac पि Arduino सॉफ़्टिेयि को इनस्क्टॉल किने के ननदेशों के ललए: 
 

HTTP://WWW.ARDUINO.CC/EN/GUIDE/MACOSX 

 

Windows पि इवंटॉल किने के ननदेशों के ललए: 
 

HTTP://WWW.ARDUINO.CC/EN/GUIDE/WINDOWS 

 

Linux पि इवंटॉल किने के ननदेशों के ललए: 
 

HTTP://WWW.ARDUINO.CC/PLAYGROUND/LEARNING/LINUX 

 
इन प्लेटफामों पि सॉफ़्टिेयि इनस्क्टॉल किने के बािे में विवतृत ननदेशों के ललए 

ऊपर हदए URLs पि जाएं | 

Arduino सॉफ्टिेयि लॉन्च किें| Tools menu में, िह बोर्स चुनें 
जजसका उपयोग आप कि िहे हैं (Tools > Board),  

िैसे Arduino Uno | 
 

अब सीरियल पोटस चुनें (Tools > Serial Port) | 
Mac पि यह /dev/tty.usbmodem जैसा कुछ होगा, 

एक विरं्ो (Windows) मशीन पि, यह COM3 या ऐसा कुछ होगा | 
 

जब आप सॉफ्टिेयि इनस्क्टॉल करने के बाद, Arduino 
कनेक्ट किते हैं तो बोिम पर जस्क्ित एक LED ऑन हो 

िानी चाहहए | 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

int ledPin = 13; 

 

void setup() {  

} pinMode(ledPin, OUTPUT); 

 

void loop() {  

UPLOAD BUTTON 

Arduino IDE आपको sketches, या प्रोग्राम ललिने औि उन्हें Arduino बोर्स पि अपलोर् 
किने की र्ें सहायता करता है। फाइल मेनू में Blink उदाहिण िोलें।  

File > Examples > 1.Basics > Blink  

जब आप Arduino सॉफ़्टिेयि र्ाउनलोर् किते 
हैं, तो आप एक IDE र्ाउनलोर् किते हैं, िो 
प्रोग्रामि को सॉफ्टिेयि विकलसत किने के 

ललए, यह एक Text Editor को कंपाइलि औि 
अन्य फीचस म के साथ िोड़ती है| 

Integrated 
Development 
Environment  

क्या है? 

Sketch को Arduino बोर्स पि अपलोर् किने के ललए, विरं्ो के 
top पि जवथत बटनों की पट्टी पि UPLOAD BUTTON पि 
जक्लक किें। जक्लक के बाद, विरं्ो के ननचले िाग में कुछ 
रै्सेि आने लगेंगे, अंत में Done Uploading आएगा | Arduino पि वपन 13 स ेिुड़ा LED जब्लंर्कंग (िलना-बुझना) स्क्टाटम कर देता है | 

javascript:void(0)


ककसी वकेच, ककसी िी िाषा में ललिे गए काय सक्रम की तिह, कंप्यूटि 
के ललए ननदेशों का एक सेट है| अगि हम Blink sketch को ध्यान से 
देखें, तो हम देिते हैं कक इसके दो बड़े पाट्मस, setup औि loop हैं | 

SETUP: एक बाि होता है जब प्रोग्रार् शुरू होता है | 
 

LOOP:  बाि-बाि दोहिाता (repeat) है | 

ये कोर् के दोनों पाट्मस, functions कहलाते हैं जो कक प्रत्येक 
वकेच र्ें होते हैं और ये curly braces { } के अंदर ही रहते हैं | 
 

void setup() {         //DECLARES BLOCK OF CODE 

  pinMode(13, OUTPUT); //SETS PIN 13 TO OUTPUT 

}                      //END BLOCK OF CODE 

 

 

void loop() {             //DECLARES BLOCK OF CODE  

  digitalWrite(13, HIGH); //SETS PIN 13 HIGH 

  delay(1000);            //PAUSE 1 SECOND 

  digitalWrite(13, LOW);  //SETS PIN 13 LOW 

  delay(1000);            //PAUSE 1 SECOND           

}                         //END BLOCK OF CODE  
 

HTTP://ARDUINO.CC/EN/REFERENCE/HOMEPAGE  
 

Arduino प्रोग्रासर्ंग िाषा सीिने के ललए िरूरी Arduino संदि स 
गाइर् औि कई अन्य संसाधनों के ललए ऊपर हदए Arduino 

िेबसाइट को देिें | 
अब इस सरल प्रोग्रार् (sketch) की हर लाइन को देखेंगे, र्क हर 

लाइन र्ें हो क्या रहा है ? 

void setup() { 

  // initialize the digital pin as an output. 

  // Pin13 has LED connected on most Arduino boards: 

  pinMode(13, OUTPUT); 

} 

 

void loop() { 

  digitalWrite(13, HIGH); // set the LED on 

  delay(1000);            // wait for a second 

  digitalWrite(13, LOW);  // set the LED off    

  delay(1000);            // wait for a second 

} 

javascript:void(0)
http://arduino.cc/en/Reference/HomePage


HOLES CONNECTED 

HORIZONTALLY 

इस ब्रेर्बोर्स में बायीं औि दादहनी साइि पर छेदों की 2 पंजक्तयााँ हैं, औि 
एक मध्य के दोनों तिफ छेद की 5 पंजक्तयााँ हैं। साइि वाली पंजक्तयााँ 
वहटमकली (vertically) कनेक्ट रहती हैं | र्ध्य र्ें हर पंजक्त र्ें 5 होल्स 

हॉररज़ॉन्टली / कै्षनति (horizontally) कनेक्ट रहते हैं | 
 

हम उन ऑब्जेक्टों को कैसे ननयंत्रित किते हैं जो Arduino बोर्स पि 
नहीं हैं? हम Arduino को एक शोल्िरलेस ब्रेर्बोर्स से िोड़ेंगे। यह हर्ें 
कर् सर्य र्ें सर्कम ट बनाने और उसको टेस्क्ट करने र्ें र्दद करेगा | 

हर् Arduino बोिम से पावर और ग्राउंि को vertically िुड़े जस्क्ट्रप्स 
र्ें बाएं और दाईं ओर, 22 गेि तार के साि िोड़ेंगे । अन्य 

कंपोनेंट्स  र्ध्य के होल्स, पावर और ग्राउंि के साि 
आवश्यकतानुसार िोड़े िा सकते हैं | 

जब LED (Light Emitting Diode) र्ें करंट सही ददशा में प्रिाह 
होता है, तो यह िोशनी देने लगता है | हम breadboard पि एक 
LED को कनेक्ट किेंगे, और कफि Arduino से, ताकक हम इसे 

अपने कोर् के साथ ननयंत्रित कि सकें । 

ANODE 

(CONNECTS 

TO POWER) 

HOLES CONNECTED 

VERTICALLY 

CATHODE 

(CONNECTS 

TO GROUND) 



UPLOAD BUTTON 

SETUP र्ें, हर् वपन-2 पर आउटपुट सेट करते हैं। 
LOOP र्ें, पहले हर् वपन-2 को  हाई सेट करते हैं, 
जिससे वो िलने लगती है | डिले (Delay) 500 

सर्लीसेकंि या आरे् सेकंि का रखते है। िब वपन-2 low 
सेट होता है, तो एलईिी बंद हो िाता है, उसके बाद दसूरे 

आरे् सेकंि का डिले देते हैं। 

LED आरे् सेकंि के सलए ON रहती है, र्फर आरे् सेकंि के सलए 
OFF रहती है और ये बार-बार ररपीट  होता है | 

void setup() {          

  pinMode(2, OUTPUT);  

}                       

void loop() {              

  digitalWrite(2, HIGH);  

  delay(500);             

  digitalWrite(2, LOW);   

  delay(500);                       

}                          
 

LED एनोि एक 220 ओर्म रसिस्टर (resistor) के र्ाध्यर् से Arduino की पपन 2 से 
िुड़ा हुआ है। कैथोि ग्राउंि से िुड़ा हुआ है। वपन 2 से 13 तक सब वपनों  को डिजिटल 

इनपुट या आउटपुट के रूप र्ें कॉजऩ्िगर र्कया िा सकता है।  
स्क्केच शुरू करने के सलए new बटन जक्लक करें। 

अपना कोि चैक करने के सलए र्ेनू र्ें Verify को जक्लक करें | यहद 
कोई भी िहुटयां नहीं हैं, तो अपने कायमक्रर् को Arduino पर चलाने के 

सलए Upload को जक्लक करें | 

VERIFY BUTTON 



Arduino पर वपन 4 से एक क्षणणक जस्क्वच के एक छोर को कनेक्ट करें और एक 
10k ओर् के रेससस्क्टर का एक छोर ग्राउंि से िुड़ा हो | दसूरे छोर को पावर से 

कनेक्ट करें | हर् LED तो उसी वपन से कनेक्ट कर देंगे | 

LED िलने लगती है िब जस्क्वच को दबाया िाता है | 

अब हर् एक जस्क्वच और एक डिजिटल इनपुट को िोड़ेंगे, 
तार्क हर् एलईिी को ON और OFF कर सकें  | 

 

अब हर् कोि सलखेंगे| SETUP र्ें, हर् वपन-2 को आउटपुट और वपन-4 को 
इनपुट बनाते हैं। LOOP र्ें, हर् एक if स्क्टेटर्ेंट का उपयोग करते हैं, अगर 
हर् वपन-4 को HIGH पढ़ते हैं, तो हर् LED वपन को High सेट करते हैं, 
अन्यिा हर् एलईिी वपन को LOW सेट करते हैं, जिससे ये बंद हो िाती है | 

void setup() {          

  pinMode(2, OUTPUT);  

  pinMode(4, INPUT);  

}                       

void loop() {   

  if(digitalRead(4)){            

    digitalWrite(2, HIGH);  

  }else{             

  digitalWrite(2, LOW);   

  } 

}                          
 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Serial Monitor 
 

CLICK TO OPEN 

SERIAL WINDOW 

एनालॉग वपन A0 को potentiometer की र्ध्य वपन से कनेक्ट करें। पॉट का 
एक छोर पावर से और दसूरा ग्राउंि से कनेक्ट करें | 

 

Sketch को Arduino में अपलोर् किने के बाद, सीरियल मॉननटि 
(serial monitor) बटन पि जक्लक किें, ताकक pot की वैल्यूि  

सीरियल मॉननटि पर देख सकें  | एक नयी वविंो ओपन होती है और  
0 से 1023 तक वैल्यूि वप्रटं होती हैं | 

 

अब हम एक एनालॉग इनपुट का सेट अप किेंगे और 
एक potentiometer का उपयोग किेंगे। 

एक potentiometer, या pot, एक 
पररवत मनीय अवरोर्क है। प्रनतरोर् की 

र्ािा उसके ऊपर बने नॉब को घुर्ाने से 
कर् या ज्यादा होती है | 

हर् सीररयल र्ॉननटर (serial monitor) का इस्क्तेर्ाल करते हुए पॉट के 
नॉब को घूर्ने से सर्लती हुयी वैल्यूि को देखेंगे। अपने कोि र्ें, हर् 
SETUP कोि र्ें सीररयल ऑब्िेक्ट को इननसशयलाइज़ करते हैं, 9600 
की बॉि रेट (Baudrate) सेट करते हैं। LOOP र्ें, हर् एनालॉग वपन 

A0 से वैल्यूि पढ़ते हैं और printLn ़ंिक्शन का उपयोग करके 
सीररयल ऑब्िेक्ट पर वप्रटं करते हैं । 

 

void setup() { 

  Serial.begin(9600); 

} 

 

void loop() { 

  Serial.println(analogRead(A0)); 

} 
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अब हर् LED को एक Dimmer की तरह कण्ट्ट्रोल करने के सलए पॉट से सर्लने वाली 
वैल्यूि को इस्क्तेर्ाल करेंगे, LED एनोि को रेससस्क्टर (resistor) के द्वारा बोिम की 

वपन-3 से कनेक्ट करें और कैिोि को ग्राउंि से | 

पहले हम pot की वैल्यू को वटोि किने के ललए एक िैरिएबल बनाते 
हैं। Setup में हम वपन 3 को एक आउटपुट बनाते हैं। Loop में, हम 
हमािे िैरिएबल में वपन A0 से पढे गए वैल्यू को स्क्टोर किते हैं। कफि 
हम वपन 3 पर वैल्यू सलखते हैं | अब हर्ें वेररएबल तो 4 से डिवाइि 
करना होगा, इसललए हमािे पास 0 से 255 तक की वैल्यूि होंगी | 

5V 

 

0V 

0% Duty Cycle - analogWrite(0) 

50% Duty Cycle - analogWrite(127) 

100% Duty Cycle - analogWrite(255) 

हम Pulse Width Modulation (PWM) का प्रयोग 

किेंगे। वोल्टेि को ववसभन्न रेट या या DUTY CYCLE से 

बदल कर, यह एनालॉग ससग्नल को ससर्ुलेट करने का एक 

तरीका है | आप 3, 5, 6, 9, 10 औि 11 वपनों पर 
पीर्ब्ल्यूएम का उपयोग कि सकते हैं | 

int sensorValue = 0; 

 

void setup() { 

  pinMode(3,OUTPUT); 

} 

 

void loop() { 

  sensorValue = analogRead(A0); 

  analogWrite(3, sensorValue/4); 

} 

िैसे ही पॉट को पावर देते हैं, की चर्क ऑफ से पूरी चर्क तक 
बदलती है । 



 

 
 

 

 

TUTORIALS 
    Arduino site Tutorials 
     http://www.arduino.cc/en/Tutorial/HomePage  
   The IoT Academy 
   https://www.theiotacademy.co/   
    Instructables 

http://www.instructables.com/tag/type‐id/category‐technol
ogy/channel‐arduino/ 

 
BOOKS 

    Getting Started with Arduino by Massimo Banzi 
    Making Things Talk: Using Sensors, Networks, and 
        Arduino to see, hear, and feel your world by Tom Igoe 
    Physical Computing: Sensing and Controlling the Physical World with      
        Computers by Dan O'Sullivan & Tom Igoe 
    Arduino Cookbook by Michael Margolis 

बस! यह एक बहुत संक्षक्षप्त 
परिचय है अगले पैनल में, 
ललकं औि अन्य संसाधन हैं| 
उन्हें यूज़ किें, आपको सारी 

िानकारी सर्लेगी | 

Links 
   Software 
       Software Download 
            http://www.arduino.cc/en/Main/Software  

       Language Reference 

            http://arduino.cc/en/Reference/HomePage 

    Supplies 
       Sparkfun Electronics 

            http://www.sparkfun.com/  

       Adafruit Industries 
            http://adafruit.com/  

       Maker Shed 

            http://www.makershed.com/  
       Jameco Electronics 

            http://www.jameco.com/  

All text and drawings by Jody Culkin for more, check out 
jodyculkin.com 
UniConverge Technologies Pvt Ltd (www.uniconvergetech.in) 
की IoT Team को देिनागिी (दहंदी) जवक्रप्ट में रूपांतिण की समीक्षा 
किने के ललए विशेष धन्यिाद | 
विशेष धन्यिाद to Tom Igoe, Marianne Petit, Calvin Reid, the 
faculty and staff of the Interactive Telecommunications.  
हर्ें यह Robust और Flexible ओपन सोसम प्लॅटफॉर् देने के सलए, 
Arduino टीर् को बहुत बहुत र्न्यवाद । 
Introduction to Arduino by Jody Culkin is l icensed under a 
Creative Commons  

Attribution-NonCommercial-ShareAlike 3.0  
Unported License.| 
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